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#3700 Characters Disappear from Font in Fontographer Win
                                                                                
Issue:
Sometimes, certain characters that you create may not show on screen or 
print, while all the other characters are fine. This only occurs with characters 
outside the main keyboard locations.

Solution:
This is because there are certain slots (character positions in the Font 
window) that you cannot use in an ANSI encoded Windows font. If your 
character was placed in one of those slots, when Fontographer creates the 
font, it must re-position the character at the end of the font. 

Note that anything placed prior to the space character (#32) will not be 
usable, as Windows has no access to characters in slots 0 - 31. Also, and 
perhaps more importantly, slots with the decimal numbers of 127, 128, 129, 
141, 142, 143, 144, 157, 158, and 160, are not usable for a font with the 
standard ANSI character set. Decimal 127 is the delete key and 160 is the 
non-breaking space. The other 8 slots are not defined in the ANSI character 
set. Obviously, it is best to simply avoid these character slots. 

But if you are pressed for just 8 more characters that just have to fit into 
your font, there is a solution. In Fontographer Windows and Fontographer 4.1 
on the Macintosh, we supply a special encoding vector named OEM or OEM 
Encoding. To use this, it is safest to set up a new font with the OEM encoding 
then copy & paste the characters into the new font. This may have to be done 
in stages, as Windows often runs out of memory when trying to copy and 
entire database of characters.
Characters 127 & 160 are till not usable in an OEM font.



Note: If you have previously been advised to use "Symbol" encoding, we want 
you to know that we now recommend OEM over Symbol. A Symbol encoded 
font will not allow for kerning pairs.

#3701 Creating a Complex Logo Font 
                                                                                
(Graphic version of this note available at www.macromedia.com 
or via Faxback 800-449-3329/415-863-4409.)
                                                                                
Issue:
A logo imported into Fontographer and generated as a font will not display or 
print properly. At some point sizes the logo appears fine but at others the 
logo is replaced by a vertical bar or an empty box. This may occur when 
viewing onscreen and/or printing.

Solution:

Step 1 - Breaking the logo apart

In order to avoid problems with complex logos it becomes necessary to break 
up the parts of the logo into separate character positions. In so doing, the logo 
will still look the same, but since it is a composite of simpler parts it will now 
print. Make sure that you choose character locations which can be accessed 
with the keyboard and are not control character sequences. (i.e. those are 
found in 0-31 of the Fontographer font window.)

Beginning with a complex logo imported from an EPS. Break it into 5 character 
positions. This is the most confusing part of the example because some 
thought must go into deciding just where to make the breaks. This example of 
our department logo is more complex than most because it requires breaking 
apart paths. In most cases, paths will remain intact, but words will be broken 
across different characters. It is important to note when copying and pasting 
the parts into new characters, never move the parts after they have been 
pasted. To do so now will make the spacing work done at the end much more 
tedious!
First, we should explain why this example is so complex. In this case, the 
original eps includes strokes and paths. Since we are interested in making a 
Type 1 or TrueType font -where strokes are not allowed- we will be doing 
some extra work in Fontographer to turn those stroked paths into outlines by 
using "Expand Stroke." 

Also, the circle in this logo, along with its "Macromedia" against the black 
background and "Service Plus" against the white, has to be divided into four 
sections which must meet precisely when typed out. After completing the 
circular border with the first 4 characters, the "M" will be typed, centered in 
the circle. Notice the two finished sections of the circle below. Each section is 
in one character cell; in this case the F and G characters. We have turned 
Preview mode off in Fontographer to better see the points in the character.

Notice how the semi-circular border around the "Service Plus" consists of two 
paths; one outer and one inner, creating a stroke effect when seen in Preview 
mode. In the original eps, the path had a stroke weight applied. We 
duplicated that for use in a font by using Fontographer's Expand Stroke 
command.



Step 2 - Getting the Paths just right

Often the eps will have paths which overlap, or even have points in a path on 
top of other points in the same path. This is no problem for a drawing 
program such as Macromedia FreeHand, but it means trouble for a font. Use 
Remove Overlap on this artwork in order to get rid of all these problems. 
Another toughie for fonts is paths with superfluous points. Fontographer 
contains a new feature in 4.x called Clean Up Paths which will remove all 
those unnecessary points without disturbing the shape of the path. 

Finally, turn the preview mode back on, which revealed one last problem, 
illustrated below_

If your font shows just the black semi-circle with no "white" letters: Not at all 
what we hoped for! You must select "Correct Path Direction" under the 
Element menu in order to correctly display the unfilled "Macromedia" against 
the black background of the semi-circle. This is important because the paths 
must be set so that the first path is clockwise, the next path counterclockwise, 
the next path (in this case a counter within a letter) clockwise, etc. Correct 
Path Direction does this automatically.

Step 3 - Spacing the parts to look as one

Now that we have the 5 parts in 5 characters and have cleaned up all the 
original paths to work properly as a font, it is time for the final step; spacing 
the 5 characters so that they look just like one when seen in the document.

Select "Open Metrics Window" under the Windows menu. This window can be 
used to preview the character positioning. Type in all the logo characters. 

Each part has maintained the same point locations it possessed when it was a 
part of the whole logo? Also, each character still has the same width as the 
original. This makes getting the spacing perfect very straightforward ñ if you 
are going to be using this font on a Macintosh!

For the Macintosh font, simply set the width of the first 4 characters to zero. 
Leave the M alone with the full width. Then when you type the first 4, the 
cursor will stay put while all the parts collide to form the circle. When the M 
is typed, it will appear centered in the circle, and the cursor will jump ahead 
to the full character width.

However, if you are using your font in MS-Windows you will not be able to 
set your characters to a zero width. You will have to manually set the width 
of your characters in the metrics window by estimating the amount of em 
units needed for the logo to display correctly.

Windows printer drivers do not appreciate the concept of a zero width 
character. They seem to like all characters to have some advance width, so 
when a character with a zero width setting is encountered, Windows will 
automatically advance the cursor, like it or not. For our purposes, we do not 
like it. So it becomes necessary to set up each part in the logo to have a width 
setting. Here are the simple steps.

Set all characters to a width of 100 except for the last one. This width will be 
the amount that the cursor advances after a character is typed. Then to offset 
for the curser advance, move the part in the character cell by 100 em units to 



the left.

Character 1 - advance width 100 ems 
Character 2 - advance width 100 ems then Move horizontally -100
Character 3 - advance width 100 ems then Move horizontally -100 x 2 = -200
Character 4 - advance width 100 ems then Move horizontally -100 x 3 = -300

Where the x 2 and x 3 equal the number of characters moved beforehand.
Drag the right-hand sidebearing of the last character out to the right until it is 
just beyond the right-hand edge of the logo. The cursor will advance to this 
position after the logo is typed.

Step 4 - Saving and Generating Logo Font Files

1. Go to "Font Information" under the Element menu, give the font a Family 
name and select the proper encoding for the project. 

2. Select "Save As..." under the File menu in order to create a Fontographer 
database.

3. Print your logo from Fontographer for testing purposes.

4. Select "Generate Font Files" under the File menu. Be sure to enter some 
bitmap sizes to output or you will not generate a screen font for the logo.

5. Install as appropriate for the destination platform (Mac or Windows).

As you type the keystrokes you will notice that the characters are displayed 
on top of each other. When you are finished typing the logo characters will 
automatically position themselves correctly.

Check for correct display as well as printing at different point sizes.

Troubleshooting

• Text in my EPS doesn't show up in Fontographer

Answer: You didn't convert the text to paths when you created the EPS.

• I get an error "Path too complex Error ID = 11500" 

Answer: The image has too many points. The image is too large and must be 
made smaller by removing objects or points.

• Syntax Error ID = 11200 

Answer: Results from trying to import an image which has no paths. If you 
are working with an image in FreeHand or Illustrator which is a scan or TIFF 
or PICT you must do an AutoTrace in order to convert this image to a path 
form.

Possible problems:

• Bezier Control Points (BCPs) or other points may lie within or on top of other 
points and may not be visible. This is why we break the artwork into 
separate characters.



Make sure your Preferences (under File Menu and "Point Display" are set to 
"Show Coordinates for Selected Points" and "Hilite Adjacent Points That 
Overlap." Use "Next Point" (Command-/) under the View menu to manually 
inspect the path direction. 

If you are following the path in the font Outline Window (using Command-/) 
and suddenly don't see a point selected but the next point is selected you 
have narrowed the problem to within two points. 

You should use "Merge Points" under the Points menu or drag a suspected 
point out of the way and delete the underlying point.

#3702 Most Commonly Asked Questions about Fontographer
                                                                                
Q: How long has Fontographer been on the market?

A: Fontographer was introduced in 1986 and has been the industry-standard 
ever since.

Q: What type of fonts does Fontographer generate?

A: Fontographer generates:

  Type 1 PostScript language fonts (a.k.a ATM fonts)
  Type 3 fonts
  TrueType

Q: Does Fontographer create GX fonts?

A: No. But we're evaluating it for future versions.

Q: Are Fontographer-created fonts compatible with Adobe Type Manager?

A: Type 1 fonts can be used by ATM to render the font to screen at any point 
size, or to print the fonts to non-PostScript printers.

Q: Can Fontographer edit more than one character at once?

A: Yes, there are many transformations that can be applied globally. Such as: 
change weight, change width, scale, skew, rotate, move, flip, auto spacing, and 
auto kerning.

Q: Can I scan a picture of my signature or logo and make it a font?

A: Yes. Refer to TN 3701 & 3711.

Q: Can Fontographer auto-trace more than one character at a time?



A: Yes. 

Q: Can Fontographer import my artwork from programs like FreeHand and 
Illustrator?

A: Yes. Fontographer has an Import EPS command.

Q: Can Fontographer output my characters to FreeHand and Illustrator?

A: Yes, Fontographer will generate an EPS file that can be used in any other 
program that supports the EPS format.

Q: Can Fontographer create fonts based on other fonts in my system?

A: Yes. As a matter of fact, Fontographer can do this in a couple of ways.

 1) You can change the weight, angle, and shape of existing fonts. So you can 
created bolder versions; condensed or extended versions; or oblique versions 
with one command. OR_ 2) You can create a completely new font by blending 
between any two fonts in your system. Refer to TN 3708 for more on 
blending.

Q: Can Fontographer be used to create foreign language characters?

A: Yes. Many of the foreign language fonts you see in use today were created 
with Fontographer.

Q: Can I take a font and make it into a foreign language font?

A: You can't automatically convert an English language font into a foreign 
language font. However, Fontographer is used by many professional type 
vendors to create foreign language fonts (either by modifying existing fonts 
or creating new fonts from scratch). 

Q: How will I access the characters once I create them?

A: The characters you create are used as a font (just like any other font in 
your system). You type and access them the same way you do your other 
fonts. 

Q: What's the difference between Type 1 and Type 3 PostScript fonts?

A: Type 1 fonts are smaller, faster to print, better looking, and work with 
ATM. However, Type 1 characters must be black filled with no stroke. Type 3, 
on the other hand, can have grayscale fills and strokes and other special 
effects. Type 3 fonts may look worse in very small point sizes and at low 
resolutions (up to 300 dpi), will not print to a non- PostScript printer and 
don't work with ATM. About 99% of the time, you will want to create Type 1 



fonts.

Q: Since I can already manipulate type in my favorite drawing program, why 
would I need Fontographer?

A: Unlike a drawing program, Fontographer will create a font that can be used 
in  any program with a font menu. This means you can use your fonts in 
programs like FreeHand, Excel, QuarkXPress and Word.

Q: Will the fonts I create with Fontographer print at my service bureau?

A: Yes! Many of our users need to output their work on high-end 
imagesetters. Fontographer can create PostScript font files that will image at 
the highest resolution of the printer.

Q: Can I assign graphics or characters to any keystroke I want?

A: Yes. Fontographer also prints out a key map showing the location of all the 
characters (in case you forget where you placed them).

Q: Will Fontographer allow me to adjust character spacing for a headline and 
package design?

A: Yes. Fontographer will automatically adjust the spacing of your entire font. 
It will do the same thing with kerning. Or, if you like to have complete control 
over every aspect of your font, you can take advantage of the advanced 
spacing and metrics options. Or manually adjust the spacing and kerning 
yourself.

Q: Isn't Fontographer just for people who want to create an entire font?

A: The majority of Fontographer users are not creating new fonts. Most have 
discovered that after having spent hundreds or even thousands of dollars on 
PostScript and TrueType fonts, they need a tool like Fontographer to get the 
most out of their typeface investment. After all, would you spend thousands 
of dollars on clip art you couldn't edit? A Fontographer user might make 
brand new fonts in order to start up a new type foundry. Most likely though, 
the Fontographer user is doing logo design; or simply adding symbols and 
dingbats to the fonts they already have. Or they could be just moving Mac 
fonts to the PC or to the NeXT or Solaris platforms. 

#3705 Fontographer Error: Could Not Open File. Error = -11501
                                                                                
Issue:
When trying to open a file in Fontographer, you get the error, "Could not open 
the file because it is in an unknown format.  Error = -11501"

Reason:
1) Trying to open the screen font instead of a printer font file or truetype 



font;
or,
2) Trying to open a Postscript_ Type 3 font which was not generated by 
Fontographer;
or,
3) Trying to open a printer font that has in some way been damaged.

1) Fontographer will not open a font with only Bitmaps in it, even though this 
font may be selected from the Open... dialog. You will need to find the printer 
font file associated with this particular bitmap font and then use the 
"File/Import" menu to import the FON bitmap.

#3708 Blending Fonts Tips
                                                                                
Issue:
"I want to use a Plain and Bold face and make a medium face by doing a font 
blend"

Solution:

The two source characters must have the same number of paths or 
Fontographer won't blend them.

1) Turn on the radio buttons for "Correct path direction first" and "Insert 
points to force match." 

2) Check to see if any characters look bad or are missing in the destination 
font. They will look bad due to mismatched path order or mismatched origin 
points. You will need to fix those manually.

1. Set the origin point at the lower right of the character, using the "Selection 
Info" dialog after selecting that point. Make sure the origin point is consistent 
for both characters in the source fonts.

2. Make sure that the paths are in the same order. (In Fontographer 4, the 
Arrange menu's "Send to front" option marks the path as last.)

3. Now try "Blend Fonts" again on that character. Click the radio button for 
"Select characters of destination font." Click off the checkbox for "Correct path 
direction first" and "Insert points to force match."

If that does not solve the problem, then other measures are necessary: 

1. Select from "Preferences" the point display popup menu that shows labels 
for all points. This will let you to see the order of the points. 

2. Insert similar point tyes in the same order and position in each source 
character and try again. This time also turn off the checkbox "Insert points to 
match." Keep it off from here on.

If your fonts do not have the same ascent/descent, you may have to change 
these settings in the "Font Info" dialog. You also may have to adjust the 
characters position on the baseline.



#3710 Windows TrueType Fonts Display or Print Anomalies
                                                                                
Issue:
I have made a Windows TrueType font in Fontographer which displays 
onscreen erratically. Sometimes it shows up as the right character, but at 
other point sizes it displays an empty rectangle.
Also, the font will sometimes print as a box to the printer, instead of the 
character. But in all situations, when I open the font back up in Fontographer, 
the character looks and prints fine.

Solution:
This is a compilation of techniques we have developed over the years to coax 
Windows TrueType fonts to print and display. Problems are usually due to 
the TrueType rasterizer which ships with Windows 3.1.x. (We highly 
recommend the TrueType raterizer in WinNT and Win95 as a great 
improvement over 3.1.x.) If you are having problems with complex characters 
(logotypes, complex glyphs, signatures, etc.) displaying onscreen or printing, 
here are a few things you can do to try to remedy the problem.

Tweaking the font:

Max X-
Windows determines how much memory to allocate to font rendering by 
checking the Max X setting in the ttf. Max X is the point with the largest 
horizontal value. If your font is based on an em of 1000, then scroll out to 
near the right hand edge of the window -at about 7700 ems - and place a 
single point. When Fontographer generates that ttf, it will not filter out that 
single point as it once did. When the font is installed, the TrueType font 
rasterizer will allocate more RAM to render characters in that font.

Avg X-
Windows averages the width of all the lowercase characters, and the space 
character, to determine how far to place the cursor after each keystroke. If 
your lowercase characters are not defined, the average is zero. In this case, 
open each lowercase letter, and assign a width appropriate to your large, 
upper case characters. This will cause Windows to allocate more memory for 
each keystroke.

Try generating the font without hints. In complex images, hinting can do more 
harm that good.

Rearrange your logo into multiple keystrokes 
When a single character is just too complex to print, break the logo into parts 
which can be placed into multiple keystrokes. In Windows, it is necessary to 
set the first character width to more than zero. If you can set it to 100 em, 
that would be sufficient. To get the whole logo, you'll then have to type 
several characters, each of which will pile on top of the last one, until the final 
character in the series finally moves the cursor to the right to give the 
character its true width. This feat is best accomplished in the metrics window. 
For more information on breaking logos into multiple keystrokes, please see 
Tech Note #17.

However, if for some reason you MUST have the character print using only 
one keystroke, divide the character into 2 or more parts, for example, in the X 



and Y character slots, and spacing as described above. Then, use the "Get Part" 
(or "Link Reference" in Fog4) command on X, and paste into A, doing the same 
with Y. This creates a composite character and fools the printer into printing 
because all the information is really in 2 slots, not 1. Bitstream has used this 
technique with some of its "L'il Bits" fonts in order for them to print reliably.

If All Else fails....tweak Windows 3.1.x

Outline Threshold 
Many logotypes when output as TrueType are too complex for the regular TT 
rasterizer in Windows. Unfortunately, though it is a memory situation, 
clearing more memory for Windows won't fix it. 

You may want to add a line to the [TrueType] section of the WIN.INI file... 

outlinethreshold=xx 

where xx is in the range of 0-300. 256 is the default value used if this line 
isn't there. Try setting it to 70. This setting determines where Windows 
switches from the TrueType rasterizer to the bigger, slower graphics 
rasterizer. 

There have been reports of this having a negative effect on some other fonts - 
those that print fine at 250, may not print at 70, and vice-versa. 
Experimenting with some intermediate values should result in a workable 
compromise, with one notable exception: if the "other font" is a Bitstream "L'il 
Bits" font, expect a crash.

Max Breakpoints
In some cases, the following line, when added to the [386enh] section of the 
SYSTEM.INI, will fix the "Divide by Zero" error which occasionally occurs when 
printing to a PostScript printer:

MaxPBs=768

#3711 Fontographer Autotracing Tips
                                                                                
Issue:
I want to take my handwriting and make it into a font. I see that 
Fontographer can autotrace background images, but the process seems 
confusing. Please explain.

Solution:
This note will address the issue for Fontographer 4.1 on both the Mac & 
Windows. Issues peculiar to each OS will be tagged by Mac or Win.

Scanning your image
Bigger is almost always better. On a 300 dpi scan, start with a drawing at 
least 2" high. Three inches is even better. When you get a character 8" tall 
and scanned at 1200 dpi, you get too much data for a clean autotrace. The 
optimum is about 4" at 400 dpi. The better the resolution of the original, the 
better the subsequent autotrace. Also be very careful to register the page on 
the scanner so that the original is not skewed. Colors will be ignored, so it is 
best to set the scanning depth to Black & White, or 1-bit. When you are ready 



to scan, save the image as a PICT file (Mac) or any convenient format in 
Windows.

Getting the background image into Fontographer
We will need to copy the bitmap image and paste it into Fontographer. Using 
a recently released paint program, open the bitmap file. We recommend 
Macromedia xRes. Painter, PaintBrush, PhotoShop, Paint and Digital Darkroom 
will also work. Don't use a program which will decrease your resolution, such 
as MacPaint. The next step is to copy the character and paste it into the 
character outline window in Fontographer. 

But first lets consider the scaling of the characters. Are the characters you 
have scanned proportionally correct? In other words, did you begin with 
drawings which had the capitals larger than the lowercase characters, with 
even smaller commas? If so, then you don't want to lose that proportion when 
pasting the font into Fontographer. 

When pasting a bitmap image, Fontographer will scale the bitmap to fill the 
em square of the font. Optionally, when pasting the image with the Option key 
depressed (Alt key in Windows), Fontographer will not scale the character at 
all. If the original size of your char was about 3", then use the Alt-Paste. 
Otherwise, you're better off making a box around the bitmap which will 
represent the em square and copy the box with the image. To begin, make a 
box which is a little taller than the "J" and a little wider than the "M" and at 
least as far down as your lowest descender (like the j or the p). Drag the box 
over the M so that there is very little white space at the top of the M. Then 
make a small horizontal mark at the bottom of the M, representing the 
baseline. Make sure the box never touches the character image. Now use that 
box with every character so that the characters will all scale proportionally. 
The box will also get traced, but it can be easily removed with two mouse 
clicks.

Now, drag each char image into the box, copy and paste the box and image 
into an open Outline Window in Fontographer, select Auto Trace from the 
Element menu, and you've got a good PostScript drawing of your scanned 
image.

The Clean Up
It is likely that some additional path tweaking will be necessary before 
everything is perfect. When Autotracing logos scanned at only 300 dpi, some 
of the smaller parts will need some adjustment. Use the background image to 
judge how close the trace is to the original scan. When you have each 
character just so, you are nearly finished with the font.

If you were not able to create the box around the character before you 
imported the bitmap, then you might need to scale and move the image now. 
Do this using the "Scale" and "Move" items in the Transform dialog for just one 
character in the font. Remember, the undo Command is Cmd-Z (Cntl-Z in 
Windows); use it liberally while you are finding the correct Scale/Move 
settings. When you have it the way you like it, note the exact scale and value 
and apply that scale to every character by selecting all in the font window. 
Now, after tweaking the handles and test printing, you should be ready to go 
with your new font.



#3712 Large Font Families in Windows
                                                                                
Issue:
ATM for Windows only allows four fonts in a font family. The styles it allows 
are Roman, Bold, Italic, & Bold Italic. (The Roman style may be called Normal, 
or Plain, or Book, etc.) Therefore, when you need to use all six weights of 
Adobe's Garamond, for example, Windows can't accommodate you. The only 
work-around for TrueType fonts is to rename the family. This will allow you 
to assign a different family name for the extra weights in a font family so you 
can access them from font menus in your favorite Windows applications. But 
the downfall of this method, is cross platform compatibility. A document 
formatted on the Mac with "AdobeGaramond-BoldItalic" will not display on 
the PC if the font name has been changed to "AdobeGaramondBold-Italic."

Solution:
Fortunately, there is a more effective solution for PostScript fonts.

Let's assume we are working with the six member Adobe Garamond family. 
When you have converted your Adobe Garamond family to PC PostScript 
fonts, open the *.inf files for all six fonts.

The fields we will be interested in are: MSMenuName & VPStyle. 

Look first at the MSMenuName field. They are all the same right now, but we 
need to change them in the -Bold & -BoldItalic inf files. This field determines 
how the fonts will appear in the font menu in Windows applications. Change 
the MSMenuName for both the -Bold & -BoldItalic inf's to "Adobe Garamond 
Bold," or anything you desire. This will differentiate it from the base four 
fonts so that ATM can install all six.

Now look at the VPStyle field. 
This uses the following code: Plain = N, Bold = B, Italic = I, & BoldItalic = T. 
As generated, the inf for the Semibold & the Bold fonts both have B. Having 
changed the MSMenuName, we now must change the VP style for the Bold to 
N, and the BoldItalic to I. Doing this will cause ATM to designate these as the 
normal & Italic styles for the Adobe Garamond Bold menu 'family.' 

Having completed this exercise, you are almost ready to install the fonts. You 
may have noticed that we have been changing the .inf file and ATM uses the 
pfm and pfb to install a PostScript font. Well, there is another way. All Adobe 
fonts for the PC ship with a mini-app named "makepfm.exe." Find this app 
and place it in the Windows \System directory with ATM. Then run ATM & 
insert your floppy with the .inf, .afm, & .pfb on it -- no .pfm! ATM will 'see' 
the .inf and call on makepfm.exe to build a .pfm from the info supplied in the 
.afm & .inf files. ATM will display the six fonts by MSMenu Name, with a style 
appended to it in all caps. This style is derived solely from the VPStyle. When 
the fonts are installed, run any app which uses fonts and you will see two 
names in the font menu, with the styles tucked safely away inside. 

Now your fonts have full compatibility across platforms and you can have as 
many PostScript fonts from one family installed in Windows as you do on 
your Mac!

#3715 Importing Font Metrics into Fontographer



                                                                                
Issue:
"I opened an existing font and generate it with a different name. Now I have 
strange leading, spacing and/or kerning."

Solution:
When Fontographer opens a font file, it reads all the pertinent information in 
that file. It does not search for related files. When opening a TrueType font, 
Fontographer gets all the relevant metrics data. However, when opening a 
PostScript font, there is some useful data missing. It is missing from the file 
which Fontographer opened, but can be found in related files, such as the .afm 
and .pfm, or the Macintosh bitmap file. Since certain metrics information is 
found only in the related files, it is important to know how to get that into 
your font.

Solution:
In order to make sure that your font will behave correctly it is wise to use 
Fontographer's "Import Metrics" feature. Here is a list of the various options 
under the Import menu:

Import Ascent/Descent

This will allow you to have accurate leading by importing the exact 
ascender/descender values for the font. This is more of an issue on the Mac 
than in Windows due to the peculiar ascender and descender values in the 
bitmap file. However, importing ascent and descent from a pfm may result in 
different values than what was read in your PostScript font.

Import Spacing and Kerning

Since kerning information is not in the PostScript font, you'll want to extract 
whatever pairs were set in your original font. This will save you from having 
to make your own kern pairs and keep you from needing to adjust the letter 
and word spacing for your font in applications which support kerning.

Importing TrueType metrics

TrueType fonts have complete metrics & kerning data which will give you the 
ascender/descender in em units. Fontographer should automatically import 
these values when opening a TrueType but sometimes changes to the font 
will change your metrics. If you suspect something is wrong with the metrics 
you should manually import them.

Importing PostScript metrics

If you want your font to have the exact appearance of its commercial 
counterpart you must import the metrics from the FOND. Apple has decreed 
that the FOND's ascender/descender should add up to a total of 4096 (or 
closely thereabouts). This is not a value in em units but an Apple system 
value. Some applications (notoriously Quark) build the leading from this 
Apple value. You can import the metrics from an AFM or PFM file when 
dealing with a PC Type 1 font.

You can also import the metrics from the NFNT resource which is pixel based. 
An NFNT resource with an ascender of 9 and a descender of 3 would have 12 
pixels for an absolute em square value.



Note: An exception to these rules would be when you have a font which has 
bitmaps which were calculated with "Preserve Character Shapes" turned on in 
the Recalc Bitmaps dialog. In this case the Ascent/Descent values will be 
different for the bitmap than they are for the outline font. You can toggle the 
two values by switching between "Preserve Line Spacing" and "Preserve 
Character Shapes" in the Recalc Bitmaps dialog.

Importing Bitmaps from PostScript fonts (Macintosh only)

It's also a good idea to import the bitmaps which come with a commercial 
PostScript font. These hand made bitmaps are often the result of many man 
hours and are to be preferred over ATM rendered bitmaps. You will find the 
bitmaps in the screen font suitcase. You can Select All or just import one of 
the point sizes. 

When you are generating the font you would enter the size(s) of these 
bitmaps in the Bitmap Font to Output field. When this font is used in an 
application you will get the commercial bitmaps at the size(s) you imported 
but all other sizes will be rendered by Adobe Type Manager.

#3716 Generating Windows FON Bitmaps
                                                                                
Issue:
"How do I create and install FON files in Windows 3.1?"

Solution:
When generating a TrueType font for Windows in Fontographer you will 
notice that sometimes the screen display is not satisfactory. This is due to the 
way TrueType hints work with a low resolution device such as a 96 dpi 
monitor. Display can also become unsatisfactory due to your video driver. Try 
selecting the generic VGA driver in your Windows Setup.

It would appear that generating a screen font is straightforward. Determine 
the point size you want and generate. But, we're in Kansas, not Oz, and things 
aren't quite so simple. First, when generating a Windows screen font on the 
Mac, one must use "The 4/3 Rule." That is due to the pixel size on the Mac 
being 1/72" while on Windows it is 1/92" or 92 dots per inch. Use the 
following formula to compensate for the discrepancy:

• Select the point size you need.
• Divide by 3 and multiply by 4 (12 divided by 3 = 4 x 4 = 16)

Thus you would generate a 16 pt in order to display it at 12 pt within MS-
Windows. The most popular sizes would be: 16,24,32,48 (For odd sizes, such 
as 10 pt, you should round up.)
Now that is the rule for the Mac; in Windows using 4.1, forget what you just 
read.

When you Generate Fonts be sure to select "TrueType" and "FON." Type in the 
desired sizes as well. You will see a *.ttf file as well as your FON files. Both of 
these will need to be installed in the Control Panel. (*.fnt files are the 
bitmapped point sizes inside the FON which you can't see or edit)



Editing FONs

Bitmaps can be hand edited for cleaner appearance by first generating bitmap 
sizes as above, then selecting "Open Bitmap Char" from the File menu ("Open 
Bitmap Window" on Mac). You can toggle through the bitmap sizes by 
selecting "Next Point Size" from the View menu. 

Installing FONs - You'll see them listed at 96 dpi in the install window

FONs will not display correctly (when installed without a TTF) unless you 
have your Default Printer set to a non-PostScript printer driver, such as a dot 
matrix printer driver.. You might see them without the driver in Paintbrush, 
but you'll need the driver to see them anywhere else. The Windows TrueType 
rasterizer uses the Printer Driver to build the fonts (as well as the Video 
Driver). Win95 has corrected all known TTF rasterizer problems experienced 
in Windows 3.1.1.

Always install *.ttf files BEFORE installing the FONs and do NOT install them 
together by doing a "Select All" or highlighting them together for installation. 
You are asking for installation problems if you use spaces in the name of your 
FONs.

Sometimes FON files (and TTFs) will not show up in the Control Panel dialog. 
This problem may be solved by removing some fonts. Moving the font to the 
top of the win.ini file has also been known to work. If you have too many 
sizes or the FON is bigger than 64K it will not install.

#3717 Characters Moving Off the Baseline
                                                                                
Issue:
All of the characters in a font get moved above or below the baseline. This is 
sometimes discovered as incorrect leading within an application. This is 
usually caused by a stray point above the ascender or below the descender. 
Problem occurs in both PostScript and TrueType fonts. This should not occur 
in Quark, Pagemaker or FreeHand but will happen in most word processors.

Solution:

1) Determine whether you have set custom leading in the Font Info dialog 
(Mac). Some applications (MS-Word or Quark for example) may have 
preferences turned on which ignore your custom leading.

2) Verify whether or not you have changed the Ascent/Descent of your em 
square.

3) Check for a stray point above the descender or ascender of one of your 
characters. Do this by:

A. For test purposes, generate a PostScript Type 1 font with an AFM file.

B. Load the AFM file into any text editor which has a search function. Search 
for "FontBBox." This is the bounding box which tells you the extreme 
dimensions of your em square. Below you will observe a clipping from an 
AFM file.



StartFontMetrics 2.0
Comment Copyright (c) 19xx
Comment Creation Date:Sun Feb 8 02:08:09 PST 1987
FontName Withheld-Bold
EncodingScheme Mac Encoding
FullName Withheld Bold
FamilyName Withheld
Weight Bold
ItalicAngle 0.0
IsFixedPitch false
UnderlinePosition -112
UnderlineThickness 51
Version 001.001
FontBBox -124 -230 1247 875
CapHeight 623
XHeight 457
Descender -225
Ascender 706
StartCharMetrics 228
C 32 ; WX 280 ; N space ; B 0 0 0 0 ;
C 33 ; WX 280 ; N exclam ; B 52 -15 229 639 ;
C 34 ; WX 400 ; N quotedbl ; B 61 353 333 639 ;

Notice the FontBBox line.
FontBBox -124 -230  1247   875 (L D R A)

L= left sidebearing
D= descender
R= right sidebearing
A= ascender

1) When diagnosing these numbers keep in mind that AFM files automatically 
normalize the em square to 1000 em units -regardless of what your em 
square is within Fontographer.

2) Take special notice of the descender and the ascender values. If the 
ascender is over 1500 or the descender below -350, it is likely that there is a 
stray point in one of your characters which is above or below the baseline.

3) You can find this character by searching for the offending value via you 
text editor's search feature.

For example: FontBBox -124 -730  1247  875

The -730 in the Descender is more than -350, so this is the value to search on. 
Your search would yield something like this:

C 44 ; WX 280 ; N comma ; B 52 -730 229 639 ;

... so, now you suspect that the stray point is in your comma character. 
Double-click on the comma position in the font window, "Select All," so that all 
points are selected. This makes the points stand out so that they are easier to 
see. Set your magnification to a small number like 12% so that you can view 
the entire drawing area.



It is possible to have problems with more than one character so scan your 
AFM thoroughly. You can Reduce view all the way out on the PC (or using the 
Magnification menu on the Mac) to get a better view of the white space 
around the character. You can now use View Next character (and Select All) 
until you see a point above ascender or below the descender.

Delete the stray point and the font will move back to the baseline after it is 
regenerated.

#3718 Hints on Hinting in Fontographer 
                                                                                
Issue:
How can I design my font in a way that will allow it to be effectively hinted?

Solution:

IN GENERAL hinting instructions will affect only:
a) the appearance of a font on screen in Adobe Type Manager and 
b) the appearance of small text type sizes when printed on a 300 dpi laser 
printer. Characters which evade hinting because they do no fall within the 
size prescriptions described below will generally not be noticeable.

1. If your version of Fontographer has the "Clean Up Paths" feature you 
should start by doing a Select All on the entire font and selecting this feature. 
Begin with a setting of 2, as this should not alter your path. This will reduce 
the number of points in your outlines and set points to the extrema of the 
path which will allow for more efficient hinting.

2. ADJUST CURVE POINTS. Place a copy of the character into the background, 
then in foreground reassign curve points to the highest, lowest, farthest right 
and farthest left sections (the extrema) of each circle or portion of a circle. 
You will be able to see in the background image just where these places are: 
they will show up as flat areas in the curving line. Place the curve point in the 
center of the flat line section.

3. ADJUST BEZIER CONTROL POINTS (BCPs). Not only do you need to place the 
curve points in the positions just described, you also need to adjust the Bezier 
handles which show up when you select a curve point. It is best that these 
Bezier handles be perfectly horizontal or vertical. Hold down the shift key 
while tugging on a Bezier handle and the handles will jump to and lock in 
either horizontal or vertical position.

4. ADD POINTS IF NEEDED. If you have placed the points at the extreme 
positions and adjusted the vertical/horizontal handles, and your curve line 
still does not match the background image, then you will need to add another 
point (not vertically/horizontally constrained) and adjust slightly to 
accommodate the curve.

5. CHECK FONT FOR HIGH & LOW POINTS. To set up height normalization 
instructions, Fontographer will be looking at some specific characters. It will 
expect that all your capital letters have a height that is positioned between 
the top of the upper case "O" and the top of the upper case "H." It will expect 
the lower measurement of capitals to fall between the bottom of the "O" and 
the baseline. If a character (such as an exotic swash capital) happens to 



extend above the top of the "O" that character will not be height normalized. 
(This will not affect the hinting regularization of stem weight.) Lower case "x" 
height in small sizes will be similarly related to the differences in height and 
depth of the lower case "x" and "o." If a character's "x" height is not within 
these parameters, it will not be affected by height control regularization, 
though it will continue to be hinted for stem width. (Special case: if the lower 
case "x" happens to have a swashing arm that rises above the general "x" and 
"O" heights, the height regularization wizard will read the top of that swash as 
the upper "x" height and will automatically put the "O" height 5 units above it, 
which would give you one heck of a high "x" height for that typeface. 
Therefore: beware of exuberant arms on lower case "x." You could perhaps 
put the fancy "x" on an option key.)

6. SERIF CUPS. Try to use a curve point between two corner points for your 
serifs. Serif regularization in small type sizes will work best if the serifs are 
the same shape, the points are in the same relationship to the baseline, and 
the height of the serif cup is not more than 6 units. Positioning the curve 
point on the baseline and corner points below it assures that the serifs fall in 
that character bottom alignment zone described in 4 above. Adobe generally 
puts their curve points on the zero baseline and corner points at -4. For a 
helpful visual description of a cupped serif, refer to the User's guide section 
on "Flex."

SOME COMMON QUESTIONS ANSWERED:
A. What happens to the hinting mechanism if a typeface has lower case 
ascenders which are higher than the upper case "O's" upper limit? Many 
typefaces are like this. ANSWER: Characters with ascenders higher than the 
cap "O" will not be normalized for height but the will still be hinted for stem 
width.

B. Must upper case serifs be the same size as lower case? Sometimes they are 
larger with a different cupping height. ANSWER: No, this will be handled 
automatically. Shape them as you wish.

C. If the circular shape is far from symmetrical so that pairs of top or side 
curve points are far from each other, will the hinting still work? ANSWER: It 
depends, how far is far? If one curve point is within the extended range of 
the BCPs of the paired curve point, yes. Where is that range? Look at the 
length of the extended horizontal or vertical BCP points. Does a line drawn 
through the extrema curve point in question at right angles to the BCP 
extended line touch that line? Then it's within range.

D. What if lower case ascenders are not all exactly the same width? An "l" 
(lower case ell) might be slightly wider than a "k" for instance. Must a cap I 
and an upper case "L" have the same stem width? Must all ascenders in the 
entire font be the same width? ANSWER: No, Fontographer will pick the most 
popular four stem widths and allocate hinted widths accordingly. 
Fontographer will allow for up to 4 common stem widths in a font.

E. Should all Type 3 fonts be converted with the curve points redistributed as 
described above, or is this primarily important for fonts that are text fonts 
with regular and straight ascenders? What about display fonts that are highly 
calligraphic, italic versions of roman texts, and fonts not meant for printing in 
very small type sizes? ANSWER: Such fonts can be converted to Type 1 
without changing the curve point positions, but it is preferable to change 
them. The subtle changes required will make the fonts look better.



F. When we talk about hinting of "small type sizes" how large is small? 
ANSWER: It is a derivative of the printer resolution and the point size. When 
a factor is applied to that, then hinting is enabled if below a certain value, and 
disabled if above. Larger sizes are unaffected by hints.

G. A roman and bold that show distinct differences at 24 point in Type 1 
appear almost the same at 12 point. Does this mean that bold versions must 
be made considerably heavier to work as "bold" in small point sizes? Then 
they are possibly too heavy in the larger sizes. ANSWER: Experiment to find a 
compromise stem width that shows up as bold in small sizes but is not too 
heavy in 24 point. Try adding 10 units to the stem width of a 1000 unit em-
squared font for starters. Add proportionally more if your em-square is 
larger.

There are many other things which can affect screen appearance: 

• Open Paths: Under the File menu you can select "Point Display" preferences 
to highlight "Unclosed Paths" and "Adjacent Points." These settings will cause 
bulls eyes and circles to appear on open paths and points within a path which 
haven't become joined. Drag these highlighted points on top of adjacent end 
points to solve the problem.

• Poor path design: If you have more points than is optimal to define a path, 
or have points incorrectly placed in the path (not at extrema), then begin by 
doing a "Select All" on the entire font then select "Remove Overlap" and 
"Cleanup Paths" (setting of 2) from the Element menu. When converting TTFs 
to PostScript fonts it is important to remember that the TTF will have extra 
points on curves which need to be cleaned up. Also, PostScripts which are 
converted to TTFs will gain extra points along curves. This is correct 
behaviour for TrueType paths.

• Bad path direction: try "Remove Overlap" and "Correct Path Direction" 

• Video drivers: try switching to the generic VGA Windows driver. 

• Cross platform screen resolution differences: Mac & Windows Fontographer 
are in a 72 dpi mode and Windows is 96 dpi. If creating a bitmap for a TTF or 
a FON file, request our Generating FON Bitmaps Tech Note. There is a 
procedure which needs to be followed to address the screen resolution 
disparity. 

• Not importing bitmaps: commercial or handmade bitmaps should be 
imported via the File menu.

• Incorrect metrics: Just to be sure, after you open a font your next step 
should be to Import Metrics. When you import the metrics be sure to get the 
Ascent/Descent and the Kerning/Spacing from the appropriate metrics file. 
These metrics will affect the hinting.

#3719 Cross Platform Font Issues in Fontographer 
                                                                                
Issue:



"How can I make a font which will work in a portable document for Mac and 
PC."

Solution:

1. Macs and PCs have different Character Sets 

ASCII is a 7 bit code which both platforms base their fonts on. The first 128 
characters will be identical on both platforms. Each platform has unique 
characters (international characters, accented characters, special characters, 
etc.) in the extended (upper 128) range. There are sometimes different 
character codes for the same character.

2. Macs and PCs have different encoding

Encoding is the mapping of a character name to a code or position. (ANSI, 
Unicode, etc.)

A PC font can be opened on the Mac with the font's original encoding and the 
first 128 characters will be in the right positions.

Symbol encoding means that all bets are off. Used for Wingdings, Dingbats 
and for the "Insert Symbol" feature used in some applications.

2. Macs and PCs have different screen resolutions

When taking a font from Mac (72 dpi) to Windows (96 dpi ) - the pixels will 
be 1/4 smaller due to the higher resolution. So, you don't really want the font 
to be identical pixel for pixel.

Guidelines for Cross Platform use of Fonts

1. Proof your font on screen and printer for both platforms.
2. Are all of the characters there? Test by using appropriate keystrokes to 
display characters on both platforms.
3. Line breaks may not break at the same place for the same text.
4. You may have to force carriage returns.
5. Enter special characters on each platform.
6. Test for accurate hinting. Hinting tells the TrueType rasterizer or ATM how 
to render the font at small point sizes. See your Fontographer User's Manual.

#3720 Where to find Fontographer Updaters
                                                                                
Issue:

"Where can I find Fontographer updaters?"

Solution:

America Online: Keyword: Macromedia, select Software Library 

File Description
Mac - FOG 4.0 to 4.03 FPU
Mac - FOG 4.0 to 4.03 NON-FPU



Mac - FOG 4.0.1 to 4.04 FPU 
Mac - Fog 401 to 404 NON-FPU 
Mac - Fog 4.02 to 4.04 FPU
Mac - Fog4.02 to 4.04 NON-FPU
Mac - FOG 4.03 to 4.04 NON-FPU
Mac - FOG 4.03 to 4.04 FPU
PC - Fontographer Win 3.5 to 3.5.1
PC - Fontographer Win 3.5.1 to 3.5.2

CompuServe: go Macromedia, Browse Software Libraries, Fontographer [12] 

File Description
Mac - FOG351.SEA 3.5 to 3.5.1
Mac - F4003.SEA 4.0 to 4.03 NON-FPU
Mac - FP0003.SEA 4.0 to 4.03 FPU
Mac - 401_4N.SEA 4.0.1 to 4.04 NON-FPU
Mac - 401_4F.SEA 4.0.1 to 4.04 FPU
Mac - 402_4N.SEA 4.02 to 4.04 NON-FPU
Mac - 402_4F.SEA 4.02 to 4.04 FPU
Mac - 403_4N.SEA 4.0.3 to 4.0.4 NON-FPU
Mac - 403_4F.SEA 4.0.3 to 4.0.4 FPU
Mac - 404FPU.SEA 4.0.3 to 4.0.4 FPU
PC - FOG351.ZIP Win 3.5 to 3.5.1
PC - FG35UP.EXE Win 3.5.1 to 3.5.2

www.macromedia.com: Menu bar selection: Tools, Fontographer, Software 
Updates

File Description
Mac - FOG403.SEA Fontographer 4.0 to 4.0.3 FPU
Mac - FOG404.SEA Fontographer 4.0.3 to 4.0.4 FPU
Mac - FOG404N.SEA Fontographer 4.0.3 to 4.0.4 NON-FPU
PC - FOG351UP.ZIP Windows Fontographer 3.5 to 3.5.1
PC - FOG352.ZIP Fontographer Windows 3.5.1 to 3.5.2

#3721 Copy/Paste or Importing EPS
                                                                                
Issue:

"I'm having problems when importing an EPS into Fontographer."

Solution:

Fontographer 4.1 for Windows works best when importing Illustrator 1.1 or 
88 files.

No strokes, fills, open paths, adjacent points are allowed in artwork brought 
into Fontographer.

Troubleshooting:

• I can't edit the artwork.

Which layer are you pasting to? It is possible to paste line art into the 



background needlessly. To change layers click on the name of the layer rather 
than in the Check Box. (The check box is only there to show the marked 
layers.)

• The image is scaled incorrectly when I import it.

If Option-Copy and Option-Paste aren't working you can put a bounding box 
around the character and bring it into Fontographer with the box around it. 
This will cause it to scale correctly.

If you are importing an EPS and the image isn't scaling correctly it's because 
the entire artboard (or pasteboard) is being saved with the EPS. Adjust the 
size of the pasteboard to be only as big as the actual object, then save the file 
as an Adobe 1.1 or 88 EPS.

• Fontographer refuses to accept my EPS file.

Fontographer will not import bitmapped EPS files. Photoshop EPS files are 
actually bitmapped images with an EPS wrapper around them. You must use 
an actual EPS file format in order to have a successful import.

Another reason that the file may not be accepted is that it is too large or 
complex to conform to PostScript limitations.

#3722 Rehinting a font
                                                                                
Issue:

"All I did was open an existing Windows TrueType font, rename it and 
generate, now it looks terrible on screen at small point sizes."

Solution:

When Fontographer opens a TrueType font, it gets all the outline data, metrics 
info, and TrueType instructions (hints). Many TrueType fonts, such as Times 
New Roman and Arial, which ship with Windows have additinal information 
in the font which enhances the screen image much like a scrren font would. 
This data is known as delta hints and Fontographer cannot read that with the 
font.

• Do a "Select All" of all characters.
• Go to Hints, Vertical Alignment Zones, Recompute, click "OK" when the 
recompute is done.
• Next go to Hints, Hint Parameters, Recalc, "OK" (If recalc is disabled then you 
don't need to recalc.)
• Finally, turn Autohint (under the hints menu) Off and back On. 
• Make sure that the "blue zones" (areas between the "hourglasses" seen on 
the left) have at least one point in the font outline to calculate on. The 
character may need to be moved into a "blue zone" in order to be hinted.
• Now, go back to Vertical Alignment Zones, Recompute " and then Hint 
Parameters, Recalc, Autohint Off and back On.

Notes



• The manual points out that Fontographer averages the stem widths of your 
characters in order to calculate the hints. Dingbats, Wingding or logo artwork 
will not have Roman character stems so it is best to rehint the font without 
these types of characters present in the font. Put them in a temporary work 
font and paste them back in with your Roman characters after the rehinting 
process. Also, if the artwork in your font is displaying or printing strangely 
you should turn off hinting before you generate the font or generate it as a 
Type 3.  

• If the above steps don't improve the character it may be because you have 
manually hinted the font which will require a voice call for us to explain how 
to fix it. (TrueType hints can't be directly manipulated in Fontographer, all 
hints are actually PostScript hints which are turned into TrueType 
instructions when the font is generated.)

• The default or normalized em square is always 1000 per the Adobe 
specifications (2048 em for TrueType fonts). The hinting may be causing the 
font corruption. We have no problems with FOG and Win 95. You may also 
have TTF RAM problems. These have been fixed in WIN 95. WIN 3.1.x users 
need Tech Note #3710 MacroFacts faxback 800-449-3329,415-863-4409, or 
via our Worldwide Web site at: http://www.macromedia.com

• Many commercial fonts (several of Microsoft's and Monotype's) use an 
expensive Delta Hint program to create their fonts. Fontographer doesn't do 
Delta hints. Here are some alternatives if re-hinting doesn't improve your 
font:

1) If you've been creating paths from scratch or creating manual hints buy: 
Fontographer Type by Design, Stephen Moye 800-488-5233. 

2) Contact Wade Farrell, Monotype's OEM Sales Manager, at 800-MONOTYPE 
(312-855-1440 in IL) or by e-mail at oemsales@monotypeusa.com for more 
information. Minimum fee to re-hint via Delta Hints is $500 (US).

#3723 Troubleshooting Font Names
                                                                                
Issue:
"I'm having problems with my font names. What are the naming 
conventions?"

Solution:

Fontographer's Type 1 PC font naming rules correspond closely to Adobe's file 
naming scheme. A legal family name is required in order for ATM to see the 
font correctly.

1) The operating system uses eight characters for a file name followed by a 
three character extension.
2) If you use a name shorter than eight characters Fontographer will pad the 
rest of the name with underscores.
3) MS-Windows treats numbers are treated as lower case. Don't use special 
characters in the name.

PC uses a 4/1/1/1/1 (max) naming convention (using Capital letters as 



delimiters -don't start a font with a lower case letter). Thus:

A family name of "JimFontCondensed" becomes "JIFC_ _ _ _.afm" but keeps its 
full family name in the app. The same font would be renamed to "jimfc___.ttf" 
if generated as a TrueType. The TrueType name comes from the Fontographer 
database name: JimFont.fog.

Generate fonts to anywhere but the WIN/SYSTEM directory (this is where 
TTFs go) nor the PSFONTS directory (where PostScript fonts go).

Fontographer/Windows Q&A

"How can I include faces under the same family name?"

You need to set weight and style in Font Attributes dialog. MS-Windows uses 
the weight to determine the placement within a family. 

"MS-Word shows all the font names in the menu instead of a family."

How to create a family for MS-Windows applications:

1) Name the parent with the same Family Name and Full name. (Testing, 
Testing)

2) Change the weight of the font so that it gives a bold appearance then 
generate the font with the same Family Name used in Step One followed by 
the word Bold (with a capital "B") Family Name: Testing Full name: 
TestingBold -now select Bold under Weight in the Font Attributes Window.

3) Skew the font and generate with Family Name: Testing Full name: 
TestingItalic -now select the Italic box under Style in the Font Attributes 
Window.

4) Change weight and skew, then generate with Bold weight and Italic check 
in the Font Attributes window using the names: Family Name: Testing Full 
name: TestingBoldItalic

*See Tech Note #3712 on Large Font Families in Windows for further info. 
Macromedia Macrofacts faxback system: 800-449-3329 or 415-863-4409.

#3724 Creating a Bold or Oblique Font
                                                                                
Issue:

"How should I bold my font? Should I just increase the weight?"

Solution:

Here are some tips on creating a bold font which is technically and artistically 
uniform when compared to the Plain version of the same font.
Before taking these steps it's a good idea to load a commercial Bold font into 
the template layer of FOG and then load that same font's plain version into 
the outline layer. If you use a serif font like Garamond you will see several 
issues which need to be addressed when viewing the outline over the 



template.
You will notice that the vertical parts of a character's design will gain weight 
faster than the thinner parts, it is not uniform. This is also true of the serifs, 
they will also gain in thickness at a faster rate than the narrower stressed 
portions of a character. Also, it is common for the serifs to become a bit 
longer. 

You'll note that the serifs become thick in relation to the thinnest stem in the 
character. Wide stems grow wider and are now out of proportion to thin 
stems. The stems will grow taller so now the character needs to be moved 
down in relation to the baseline.

The above scenario isn't as prevalent in evenly weighted or unstressed fonts, 
such as Avant Garde, Helvetica, or Futura. But they are noticeable in the 
condensed versions of these faces, as condensing the font will often create 
stresses, especially where bowls and loops connect to the stems. 
Characters should be scaled in order to remain perfectly sized in relation to 
the em square.

Here are some steps which you may apply to your Plain font:

1) Select all (except composites)
2) Change Weight (try about 70% of the difference between the existing font's 
width and the width you desire).
3) Keep all boxes checked on: Path Direction, Don't change horizontal or 
vertical
4) Note serifs and stress points for uniformity

Finally, it's impossible to tell you exactly what to do because these 
instructions will differ for font characters which have both thick and thin 
stems versus a font which has uniform size stems.

Note: keep in mind that the Change Weight feature can cause stems to grow in 
such a way as to overlap other parts of the character, counters can become 
filled, etc.

Credit where credit is due:

This note has been heavily influenced by the new book: Fontographer: Type 
by Design by Stephen Moye from MIS. (ISBN 1-55828-447-8) The book 
contains more details on creating styles for your fonts. 

#3725 Two-Byte Fonts in Fontographer 
                                                                                
Issue:

"How can I create large character set fonts? How many characters can I create 
in a font?"

Solution:

Fontographer Windows has a limit of 4,095 characters per database. Mac FOG 
has a limit of 8,192. You will need to create more than one database/font 
generation if you need more characters.



Characters above 256 in MS-Windows (as with all the other characters in the 
font) can be accessed via Unicode. Get a copy of the "Unicode Standard" book 
from Addison-Wesley. You will need to buy either an Operating System such 
as "Japanese MS-Windows" or find a keyboard driver and an editor which 
supports your Unicode characters. Try Eastern Language Systems (801-377-
4558) or Gamma (310-451-4725) for some product info on these issues.

You'll need a special MS-Windows driver from Microsoft in order for your 
keyboard to access the Unicode characters. WIN 95 recognizes the entire 
Unicode book whereas Windows 3.1.1 only recognizes ANSI Unicode values.

Use the Character Info dialog under "Element" and "Selection info" menu 
selections to add characters above 256.

For more info on Unicode, Code Pages, cmap tables, input systems, keyboard 
drivers, localization, etc. use a Web browser to search the Web via 
http://www.yahoo.com -search for "language" or "fonts" and you'll get plenty 
of info and font nerds to talk to.

Or... check out Multilingual Computing Magazine, 111 Cedar, Sandpoint, ID 
83864 208-263-8178 (info@multilingual.com)

#3726 Converting point sizes and picas to em units
                                                                                
Issue:

"I need to move a character within the em square the equivalent of one pica. 
I want a character to display in the screen at an exact point size only."

Solution:

1) Determine the exact point size you want this effect to occur at. If you want 
several sizes you will have to make separate fonts (or bitmaps) for each size. 

2) Determine how much you want to move the character in points or picas. 
There are 12 points in a pica.

Example: 

I want to move a symbol character one pica (or 12 points) higher (vertically) 
within the em square.

A. What is the desired point size? 72 pt. 

12 = ___% of 72? Answer is: 16

B. What is the height of the character within the em square? 450 em units

C. 450 is what percentage of the em square? 
(Most PostScripts are 1000 ems / TrueTypes are normally 2048) 450 = 45% of 
1000



D. 16% of 1000 = 160 em units

E. Move the character up 160 em units (Select all and use the arrow keys to 
move incrementally).

The character is now positioned at 450 (old height) + 160 ems which is one 
pica higher than it was originally.

Use the above formula for your font by determining:

What point size will be used?
What percent of that point size is the move?
What percent of the em square would this value be in em units?

#3727 Making Zero Width Accent Fonts
                                                                                
Issue:

"I'd like to create a font which allows me to have more accented characters 
than are in an Adobe Encoded font, but there are not enough slots left in the 
font. Is there a way to have the characters and accents in the font in different 
slots but still displayed properly?"

Solution:

The purpose of making a zero width accent font is to make a font that can 
accent more characters than are normally accented in a normal 256 character 
font. The exercise in this lesson will walk the reader through the process of 
making just such a font. Some basic terms should be defined before we 
proceed further. 

Definitions:

Ascent: The ascent line marks the top of the tallest letters, normally the 
capital letters.

Baseline: The imaginary line on which the capital letters and many of the 
lowercase letters rests. The Ascent and Descent values are calculated from the 
Baseline.

Descent: The descent line marks the bottom of the lowest letter, often the "y" 
or "g".

Em Square: The Em square is the area where the letters of the alphabet are 
drawn. Its em square equals the Ascent plus the Descent values added 
together.

Em Units: In a PostScript font, an Em Unit is 1/1000 of the Em Square and is a 
basic, if relative, unit of measure in Fontographer.

x Height: A general imaginary distance that is the average height of those 
lowercase letters that have neither Ascenders or Descenders, i.e.: a, c, e, m, n, 
o, r, s, u, v, w, x, z. It is called the "x" height because the letter 'x' most closely 



describes this distance in most fonts.

IMPORTANT NOTE: This instruction depends on kerning. Many programs do 
not support kerning. The font you will develop using these instructions will 
not work correctly in such programs. However, programs such as Quark 
Xpress, Pagemaker, Ready Set Go, Illustrator and FreeHand do support 
kerning, and the font will work well with them.

This note does not guarantee success, nor will it provide a complete font. It is 
simply a demonstration of principles which one can use to develop fonts that 
require complex accented characters. This exercise is being done on an 
American Keyboard.

1. Start Fontographer
2. Open new untitled font (File/New)
3. Carefully select and Shift select the letters A-Z, a-z, all numbers, basic 
punctuation ( ! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ ) and the 12 accent 
characters in the face Times Roman. 

You select them by clicking on the letters in the font window (the grid like 
window where all your letters are displayed in small squares) and then 
holding down the shift key and clicking on the ones you didn't catch. As you 
select the letters the boxes they are in will turn black. Once you have selected 
all the letters, Copy them (Edit/Copy), then go to the new untitled 
Fontographer database you opened in step 3, select and Shift Select the 
identical letter spaces i.e.: A-Z, a-z, all numbers, basic punctuation ( ! " # $ % & 
' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ ) and 12 accent characters and then Paste (Edit/Paste). 

4. Go back to the Times Roman Fontographer database. In the upper left area 
of the font window grid there are the words View by: followed by a box with 
the word Character and a small triangle in it. Click on this box and a list of 
words will drop down. Holding down the mouse button, drag down to the 
word Width. Then Scroll the window up (click on up arrow in Scroll Bar) till 
you see the Exclamation Mark ( ! ). 

Above it is the number 333. That is the width of the character. To the left of 
the Exclamation Mark ( ! ) is a blank box. But it has a Width of 250. This is the 
Spacebar width, which provides space between words on your keyboard and 
in your documents. Note that value- 250. 

5. Then go to your new Untitled Fontographer Database, select that same box 
(the one to the left of the Exclamation Mark) and then go to Metrics/Set 
Width... . You will get a dialogue box with some Buttons and a Field. The 
button you want to have selected is the one next to Set Width to:, so if it isn't 
selected (Black) then select it by clicking on it. Then in the box next to the 
words "Set Width to:" select the number in that box, delete it, and type in the 
number 250. Then click the OK button. This will make the Width of the 
Spacebar you selected 250 Em Units. 

6. At this point we no longer have any use for the Times Roman Fontographer 
Database. So go to the Times Roman Fontographer Database and select 
File/Close. You will get a dialogue box asking you Save changes to the font 
"TimesRoman" before closing?. Click on the Don't Save button. 

7. At this point you should have an Untitled Fontographer Database open. We 
will now title it. Select Element/Font Info... You will get a dialogue box. In the 



field under the word Family Name is the word Untitled. Delete the word 
Untitled, and type in the word Phonetics and then click the OK button. You 
will notice that the name in the Title Bar is no longer Untitled, it is now 
Phonetics.

Part 2

1. Go to View by: and set it to Decimal.

2. Select and shift select the accents. Copy them 
(Edit/Copy). Then select these 12 decimal spaces: 160, 161, 162, 163, 164, 
165, 166, 167, 168, 169, 170, 171, and then Paste (Edit/Paste). 

3. Shift Select #168 and 170. This will deselect them from the others. At this 
point you should have the following characters selected: 
160,161,162,163,164,165,166,167,169, and 173. 

Remember when we checked the lowest point of the lowest accent (the 
caron)? It's lowest point was 507. But the highest letter, the O, is at 676. And 
we want the accent to clear the O by 60 Em Units. We will have to move the 
accents up. 

Go to Element/Transform.... You will get a dialog box. Under where it says 
First transformation: there is a box with a downward pointing triangle. Click 
on that box and drag to the Move selection. With Move selected, under the 
word Horizontal enter a value of zero. Under Vertical enter 211. (That value 
will move the lowest part of the accents 60 Em Units higher than the top of 
the O.) 

Then click on Transform. You should see the accents move up slightly. These 
will be the accents we will use over the Uppercase vowels. The lowercase 
letters will fit comfortably under the other accents, so we won't be moving 
them vertically at all.

4. Select all the accents. Go to Metrics/Set width... "Select Set Width to:" (if it 
isn't already) and type in the neighboring box the number zero ( 0 ) em units. 
Now, all the accents will have a zero width, and will appear over characters 
following. But they won't appear very evenly. The way you adjust that is in 
the Metrics window.

5. The accent characters are placed too far to the left in their Em Squares. To 
correct this we are going to take all the lower case accents (decimal #s 
171,172,246-255) and move them 50 units to the right. 

a. Select the accent characters (decimal #s 171,172,246-255)

b. Go to Element/Transform...

c. Select Move. Set Vertical to zero and Horizontal to 50. Click Transform 
button.

6. The uppercase accents need to move much farther. Select the Upper case 
accents (160 -167,169, and 173) and then go to Element/Transform.... Select 
Move. Set Vertical to zero and Horizontal to 120. Click Transform button.

7. Now the hard part. You have to go in and adjust the kerning of each letter 



in relation to the accent mark. Because each letter is designed differently, the 
kerning has to be different to reflect that. For instance the lowercase o and 
the lowercase e. They share the same width and many similar features, but 
the stresses in the top of the e are very different from the o, requiring the 
kerning to be different depending on the accent. 

To adjust the kerning, go to your Metrics Window. Type a lowercase accent 
character and then the character you wish to kern (start 
with an 'a'....) It doesn't look too bad! You could leave it and go on to the c or 
e, (to do that, type Command ] for next letter and Command [ for the previous 
letter) but it's just a little tiny bit too far to the right. 

At the bottom of the Metrics window are data fields for the acute and the a. 
The lowest field is the Kern field. In the kern field for the letter a, type in the 
number 20 and press the return key. You will see the a shift to the right 
slightly, and the acute accent will look more "centered" above the letter. 
Go through all the combinations you think you'll need. If you only do the 
Vowels, it will only be 144 combinations, and you can get through that 
quickly once you're in a rhythm of kerning. 

Also, if you shift your accents carefully (perhaps 50 Em Units was too far- 
perhaps we should have done it 43 Em Units...) you may not have to do much 
kerning at all! Similar work will be done with the upper case letters. You now 
have a font with accents over many letters! Generate your font as you 
normally would according to instructions in our manual. 

#3728 Online Font Sources
                                                                                
Issue:

"Where can I find public domain fonts and utilities?"

Solution:
CompuServe: Macromedia forum, DTPFORUM, JWORLD (Jerry's World)

America Online: Macromedia forum, Computing and Software forum, MDP 
forum, FONTBANK

http://jasper.ora.com/comp.fonts/index.html (Internet Font Archive)

http://www.jworld.com

http://www.quixote.com/serif/about.html (Web site for Serif Magazine)

http://www.dol.com/typelab (Web site for FontLab)

http://www.hkstar.com/~idn

http://babel.uoregon.edu/yamada/fonts.html (International fonts for PC)

http://www.knowledge.co.uk/xxx/mpcdir/ (Multilingual PC Directory)

http://www.typeart.com



typo-L (Newsgroup)

typetalk@hookup.net (Newsgroup)

comp.fonts.newsgroup (Newsgroup)
Resources
Fontographer: Type by Design, Stephen Moye, MIS Press. (ISBN 1-55828-447-
8) 800-488-5233

How to Boss Your Fonts Around, Robin Williams, Peachpit Press (ISBN 1-
56609-102-0) 800-283-9444

BMUG Shareware Disk Catalog by Noah Potkin from Addison-Wesley

Mac Shareware 500 by Ruffin Prevost from Ventana Press (four disks 
included)

The Font Catalog from Hyperactive Software 612-724-1596

Scriptorium Font Library from Ragnarok, P.O. Box 14033, Austin, TX 78714

Multilingual Computing Magazine, 111 Cedar, Sandpoint, ID 83864 208-263-
8178 (info@multilingual.com)

* Your FOG Sample Fonts Folder has Public Domain fonts: Civitype, Goudy 
Hundred, Livia, Final Roman, Opaque Counters

#3729 Fonts & Copyrights
                                                                                
Issue:

"What are the copyright issues involved while using commercial fonts in 
Fontographer?"

Solution:

We can't give legal advice on copyright issues but here's the protocol...

1) First of all, call the maker of the font and ask for any details you may need 
in the font's licensing agreement. See the Copyright Notice field in FOG for the 
name of the copyright holder. You must treat a font as you would any other 
software licensing agreement.

2) If you are creating a commercial PostSript font, you need to acquire a 
Unique ID number from Adobe Systems. Terry O'Donnell is the keeper of the 
ID numbers. His number is 415-962-3836.

3) Here's a source for finding out whether a font name has been used or is 
copyrighted is Tim Ryan's Typeface NameBase._ The NameBase lists font 
names, designers, dates of creation, originating foundries as well as 
information regarding who owns and distributes the fonts at this time. 

He has compiled information on over 20,000 fonts. Tim can be contacted at: 
SourceNet, 1728 North Moorpark Road, Thousand Oaks, CA 91360. Phone: 805 



494 7123 Fax: 805 497 3790 
AOL: SOURCENET@APPLELINK.APPLE.COM

4) Finally, call the Software Publishers Association 800-388-7478 for legal 
advice on these issues.

#3730 Mu and Mu1 character definitions in WIN95 fonts
                                                                                       
Issue:

"When I try to enter the Mu character using Alt-0181 in Win95 the character 
doesn't display."

Solution:

Microsoft changed the TrueType Specifications. In TTF Spec 1.6.6 you will find 
that character 181 is now defined as the Mu1 character and the Mu has been 
moved to decimal slot 455.

If decimal slot 181 is empty but there is a glyph in slot 455 you will get the 
glyph from 455 when you enter Alt-0181. This glyph will display and print 
as if it were located in decimal slot 181. If slot 181 has a glyph in it there will 
be no substitution.

Note: If you are loading a non-Fontographer font into Fontographer 4.1 for 
WIN95 you should set your preferences under the File menu to Open the font 
with the "Font's Original Encoding."
You should also set the preferences so that when the user types a key the 
"Font's Original Encoding" will be used. This will cause the old Mu character in 
slot 181 to be moved to 455 when the font is loaded.


